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Device 

Warnings, Cautions, and Contraindications 

 

Warnings 

A warning indicates the possibility of injury to you or the operator of this device

This manual serves as a reference.  

Read and understand the entire manual before using the device. 

Discontinue use if skin reddening or inflammation appears. 

Do not smoke while wearing the BMC SleepCare. 
Do not use USB data cable for communication to PC while the device is recording. 

Cautions 

A caution indicates the possibility of damage to the device. 

This device is to be sold by or on the order of a physician. 

Avoid exposure to sources of direct airflow such as fans during recording. 

Avoid using this device in an MRI environment or in close proximity to a high EMI emission 
source. 

Do not attempt to take the main device apart. No user-serviceable parts are inside. 

Do not immerse the main device in water. 

If you notice any unexplained changes in the performance of this device, if the device is dropped 
or mishandled, if water is spilled into the enclosure, or if the enclosure is broken, discontinue use 
and contact BMC.  

Contraindications 

Depending on your skin condition or general state of health, you may experience sensitivity to 
the wrist belt or the self-adhesive finger sensor. Discontinue use if you experience a reaction to 
the skin-contact materials. 
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Intended Use 

The SleepCare device is indicated for the screening of  sleep disordered breathing. It records the 
following data: patient respiratory oral and nasal airflow, snoring, blood oxygen saturation, pulse 
and CPAP pressure. The device uses these recordings to generate a report for screening or for 
further clinical investigation. 
 

System Contents 

1 User manual 
1 SleepCare main device 
1 USB data cable 
1 Pulse oximeter sensor 
1 Oral and nasal airflow unit (optional)  
1 Cannula （optional） 
1 CD 

 

Figure 1-1 System Contents 
 

Several accessories are available for using the SleepCare. To ensure that you experience a safe and 
effective use, adopt only BMC accessories. 
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Symbols 

These symbols are used on the SleepCare devices. 

        Type B Applied part 

        Attention, Consult Accompanying Documents 

IPX0        IPX0 Ordinary Protection             

SN          Serial Number of  the product 

         Date of  Manufacture            

         Manufacturer                

   Authorised Reprisentative in the European Community 

   European CE Declaration of  Conformity 

 

SleepCare Display 

 

 
Figure 1-2 SleepCare Display 

 %SpO2 Display 

Display the value of  percent oxygen saturation. 
 

 Pulse Rate Display 

Display the pulse rate in beats per minute. 
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 Recording Time 

Show the length of  recording time 
 

 CPAP Pressure 

Display the direct component of  airflow pressure. 
 

 Pulse Waveform 

The yellow line depicting the artery pulse feature  
 

 Snore Waveform 

The green line indicating the occurrence of  a snore 
 

 Respiratory Waveform 

The red line reflecting user’s respiration fluctuation 
 

Instructions for Use 

Fitting  

1. Remove the SleepCare main device, oral and nasal airflow unit, pulse oximeter sensor and the 
two batteries from the package. 

2. Open the battery door at the left side of the device. Insert two new AAA batteries following 
the polarity markings indicated on the battery door. Carefully position the battery door and 
gently get it into place. 

3. Fit the oral and nasal pressure cannula so that the two small open tubes point towards your 
nostrils while the third open tube pointing towards your mouth.  

4. Fit the loop round your ears and then back around your neck, avoiding pulling it over your 
head.   

 

 
Figure 1-3 Illustration of Wearing the Cannula 
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5. Move the slide towards your chin, until the cannula feels secure under your nose. 
6. Fit the farther end of  the cannula into the tubing end of  the oral and nasal airflow unit and 

insert its data cable into the left port at the main device bottom, where the recorded data 
could be downloaded by a computer. 

7. Put the oximeter data cable plug into the right socket at the device bottom. 
8. Insert your index finger into the pulse oximeter sensor. The finger must reach the end of  the 

sensor. 
 

 
Figure 1-4 Illustration of Wearing the Pulse Oximeter Sensor 

 
9. Wear your SleepCare main device around your wrist just like wearing a watch. Adjust it for a 

comfortable position and fasten the belt to make it fixed. 
 

 

Figure 1-5 Illustration of Wearing the Main Device 
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Recording 

 
Figure 1-6  Main Device 

 
1. Start the device by pressing and holding OK button, the four icons, Record, Setup, 

Archives, and About, are showing in the display. 
2. Navigating the icons via Shift button and select the intended function by pressing OK 

button.  
3. Setup allows changing some of  the recording parameters. For example, you can choose 

whether or not save flow data, whether or not save snore data, and whether or not need an 
auto save. You can also set an appropriate time span for Backlight Time. The default value is 
30s. The exit icon makes you quit the current page and return to the previous one. 

4. Record. When this icon is selected, the device enters the recording page. 
5. Archives. This icon offers information on serial number and recording time. The device 

allows a maximum volume of  32 pieces of  entries or 29 hours of  accumulated time, though 
only the latest 8 pieces of  data files can be seen through this interface. Check it when you 
transfer the recorded data to the computer. If  new data are recorded while the storage is full, 
the most beginning one of  the recorded data files will be overwritten. Press any key to quit. 

6. About. This icon gives information regarding the product version. Press any key to quit. 
7. The device automatically turns off  in one minute if  no action is taken in this page. 
8. While recording, the OLED colorful display will be off  after a set time since the last 

keystroke and it can be activated again by another hit on the key. 
9. Follow the direction of  the 4th step to enter the recording page, then press and hold OK 

button to start recording. The timer in the up left corner begins to run. Keep the device on 
and go to sleep.  

10. Press and hold both Shift and OK buttons at the same time to quit record process. 
11. Press and hold OK button to turn off  the device. 
12. The recorded data can be uploaded to a computer by USB communication port, refer to the 

part of  Analysis System in this manual. 
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Disassembly 

1. Lower the slide from under your chin and take off  the cannula. Take off  the pulse oximeter 
sensor. Unplug the data cables from your SleepCare main device. 

2. Put the cannula off  your oral and nasal airflow unit and keep it for future personal use 
according to your medical provider’s instructions. 

3. Remove the batteries and discard according to local regulations. 
4. Keep your SleepCare main device and the accessories appropriately under the instructions of  

medical provider. 

Important Steps for Use 

It is of  essential importance to have the OLED display screen checked to ensure an effective and 
correct recording before sleeping. 
The red line indicating respiratory waveform must be fluctuating with your breath rhythm, while 
the yellow line which corresponds to your pulse fluctuation should also change itself  thereupon. 
You can also check the SpO2 and PR (Pulse Rate) by commonsense to see whether the pulse 
oximeter sensor is in good position for operation. 

Troubleshooting 

 
Symptoms Possible Cause Possible Solution 
OLED display blinking Batteries are low. Replace batteries immediately. 

Batteries incorrectly inserted. Check batteries. SleepCare will not activate. 
Depleted batteries. Replace batteries. 

The red line keeps straight 
without fluctuation. 

The cannula is not properly 
positioned or is not connected to 
the main device, or is pinched. 

Adjust the cannula and make sure 
it is connected firmly to the main 
device, or contact your medical 
provider for a change. 

The yellow line does not move. The pulse oximeter sensor may 
not in the correct position. 

Adjust the pulse oximeter sensor.

 

 

Specifications 

 
1. Oxygen Saturation Range                                         0 to 100% 
2. Pulse Rate Range                                               40-240 bpm 
3. Oral and Nasal                                       10/minute~40/minute 
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Airflow Rate Range 
4. Wavelengths 

a) Red:                                    660 nanometers @ 3mw nominal 
b) Infrared:                                 905 nanometers @ 3mw nominal 

5. Accuracy 
a) %SpO2 Accuracy                                      70 to 100% ±3% 
b) Rate Accuracy                                the larger of  ±3% and 1bpm 

6. Resolution 
a) SpO2                                                            1% 
b) Pulse Rate                                                      1bpm 

7. Temperature 
a) operating                                                   5℃～40℃ 
b) storage/Transportation                                    -20℃～+55℃ 

8. Humidity 
a) Operating                                    30% to 80% non-condensing 
b) storage/ transportation                             ≤93% non-condensing 

9. Atmosphere Pressure 
a) Operating                                            860hPa~1060hPa 
b) Storage                                              500hPa~1060hPa 

10. Power Requirements                               2 AAA Batteries of  1.5 VDC 
11. Batteries Life 

a) Operating                   approximately 18 hours of  continuous operation 
b) Storage                                               9 months typical 

12. Dimensions                                       62mm × 57mm× 21mm 
13. Weight                                     70g (main device without batteries) 
14. Classifications per IEC 60601-1 
 
Type of  Protection                           Internally Powered (on battery power) 
Degree of  Protection                                         Type B-Applied Part 
Degree of  Protection Against Ingress of  Water               IPX0 Ordinary Protection 
Mode of  Operation                                                 Continuous 

Cleaning  

Caution: 
• Never use abrasive agents, alcohol, chlorine-containing substances, acetone, or other solvents 
to clean the recorder. 
• Do not immerse the recorder, the oral and nasal airflow unit, or the pulse oximeter sensor in 
fluids, and ensure that no fluids penetrate into the products. 
• Do not attempt to disinfect or sterilize the recorder, since this could cause unseen damage to 
the inside of the unit. 
1. Turn off the SleepCare. 
2. Detach the oral and nasal airflow unit and the oral and nasal pressure cannula. 
3. Detach the pulse oximeter sensor from the SleepCare main device. 
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4. Clean the following parts with a damp cloth and a mild liquid soap: oral and nasal airflow unit, 
pulse oximeter housing and pulse oximeter cable. 
5. Leave the cleaned parts to dry. 

Disinfection 

Between patient uses, the SleepCare should be surface disinfected in accordance with established 
clinical practice. 

Disposal 

Dispose of the device in accordance with local regulations. 
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Analysis System 

System requirements for running the software 

1. hardware requirements: CPU≥P3 1.0G, memory≥512M, display resolution 
≥1024×768， hard disk ≥80G 

2. software platform: windows XP 

Setup and registration 

Setup of the software 

a) Run the “SETUP.EXE” of SleepCare in the installation CD and enter the setup page 
b) Click “Next” to enter the user information input page 
c) Input user information and click “Next” to enter the installation directory page 
d) User does not need to change the default directory of ‘D:\ BMC_PSG’, click ‘Next’ to 
enter the setup information verifying page. 
e) Click ‘Next’ to make the software auto-install. 
f) Click ‘Finish’ when the installation is done to quit. Double-click the new shortcut on 
desktop to launch the software. 

Registration  

a) Using the software for the first time requires a registration whose information could be 
found in a file named after the user in the installation disk. 
b) Connect the SleepCare to the USB port of PC using a standard USB data cable.  
c) Double-click the shortcut on desktop to enter the registration page (see Figure 2-1). 
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Figure 2-1 User Registration 
d) Click “Connect”. The information of Sleep Holter ID appears in the relevant field 
automatically. 
e) Enter serial number in the first blank field and registration code in the last and click 
“OK”. They can both be found in RegisterCode.txt in the disk. 

Data reception 

Data reception is to transmit the recorded data to computer. Software will analyze the 
data, and then the operator can edit the results of the analysis to generate analytical 
reports. Data receiving process is expressed as the following steps: 

Start software 

Firstly double-click shortcut of the software icon on the desktop, the system will enter 
the SleepCare system main window. 

Connection of SleepCare and computer 

In the power off status of the SleepCare, connect one end of the playback cable with the 
computer USB port, connect the other end to the SleepCare playback socket and then 
turn on the SleepCare. 

Data transmission 

a) When the recording is ended, transmit the data into computer. Computer software can 
analyze the data. Then the operator can edit the results of the analysis to generate 
analytical reports. 

b) Run the software and choose the “File” from the main menu, select "New" to enter 
the communication interface. Select USB port and click “Connect”. 
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Figure 2-2 Sleep Screener Online 

c) If connection succeeds, the "Connect" button will be grayed. And other originally 
grayed unavailable buttons will be available now. After online with the computer (see 
"connection of SleepCare and computer"), SleepCare will automatically enter the 
communication status. 

After the success of online, click "Replay" button in “Sleep Screener Online” dialog box 
and the replay dialog box pops up (Figure 2-3). 

 
Figure 2-3  SleepCare Playback 

d) The first content is data filename. The second is data type. Having the above two 
contents set up, click "OK" and the pop-up dialog box of patient information (Figure 2-4) 
is then shown on the display screen. 
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Figure 2-4  Patient Information Input 

e) Recording start time is set by system at the beginning of the recording time which is 
confirmed by the internal clock. If the SleepCare clock is not correct, you can modify it 
in the above login screen. The recording end time defaults to 12 hours after the record 
start. In fact, in the process of data transmission, the system can automatically identify 
the actual end time of record. SleepCare will automatically stop after data transmission is 
finished. So need not to change the recording end time in normal situation. 

f) Enter patient information one by one. 

g) When the login information input is finished, select “OK”. Then computer begin to 
receive the recorded data. When data transfer is finished, the system returns to 
communications dialog box. At this time select "disconnect" or "return" in the dialog 
box, SleepCare will then automatically exit from the communications status. 

h) If you want to connect another SleepCare with the computer, you can repeat the 
process of data reception. If you do not need to transmit data from other SleepCare, you 
can select "back" button in the communication to return to the main menu.  

Data file management 

a) In the main window of SleepCare system, choose “Open” in “File” of menu bar, the 
system will enter the sleep data management interface. The screen shows the saved data 
and its related information in the hard disk (Figure 2-5). The desired data can be easily 
found out by different ranging manners in this page. You can also verify the device’s 
storage capacity of 32 data files against the eight ones displayed on the SleepCare device. 

b) First of all, find out the route and catalog of the sleep data, you can also make it by 
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using the Browse button. Then all the files are listed, with the information such as file 
name, patient name, serial number, recording date, record length, person on duty and 
data version etc. Click on the appropriate classification column according to which the 
files are ranged to alter the files’ order. 

c) In the lower right of the page are the function keys such as Open, Backup, Delete, 
and Cancel. With mouse clicking the file name, you can select the file, and then select 
the appropriate function key to achieve data playback, data backup and data deletion. 

d) Selecting the cancel button in the lower right of the page can return to the main 
window of the SleepCare system. 

 
Figure 2-5  Select Data File Dialog Box 

Data playback 

Under the sleep data management page, select the sleep data file, system will enter the 
data playback interface. 

If  the data have not been analyzed yet, the prompt of  auto analysis will be shown on the 
screen.  

After opening the data file, system will enter the data playback window. There are the 
trend chart, the waveform, the diagnosis result, the analysis report and other pages. 

Open and close the data file 

a) Multiple data files can be opened simultaneously in the main window of  the SleepCare 
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system. For the method to open the data files please see the data file management part. 

b) Opening a file may be failed if  the file is being used. 

c) Select the intended file name in the Window menu to open the file. 

d) Clicking  in the toolbar or select “Close” in the “File” option in the menu may 
close the current window of  data file. 

Display of recorded data and analysis result 

The data recording, analysis result and statistical result are shown in 5 pages. It is in turn: 
The trend, the raw data, the respiration event, the diagnosis result, and the report. The 
report includes the concise report, the apnea analysis, the SpO2 analysis, and if  the 
CPAP pressure is allowed, CPAP pressure report is also included. 

The first chart displayed in the interface after the file is opened is the trend 

chart and other pages , , 

,  can be shown via clicking the corresponding tabs above. 

 

Trend chart 

The trend chart demonstrates all the recorded parameters and analytical results during 
the entire recording time. By demonstrating multiple parameters, one may observe the 
different physiology parameters in the same period of  time conveniently and may study 
the relationship between them easily. 
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Figure 2-6  Trend chart 

The basic functions on the page are: 

①Parameter browse 

②Parameter deletion 

③Event location 

④Print 

⑤Analysis 

All the operations may complete through the menu choosing. Regarding the commonly 
used operation, besides the provided menu operation, they may also be done by clicking 
on the toolbar buttons. 

 

①Parameter browse 

The two buttons  in the toolbar may enlarge and reduce the time axis for 
glances over the record parameter according to the different time resolution of  the 

tendency change. Clicking the two buttons  may make the cursor move forward 

and backward. The button  may open or close the display-assistant window, which is 

able to show each kind of  parameter value at the present time (where the cursor is). 
Clicks with a mouse throughout the trend chart can drive the cursor to anywhere in it. 
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At the lower part of  the trend chart lays a slide scale which can be dragged left and right 
to change the cursor position. 

The main part of  the window shows the data analysis result trend chart. The items in a 
top-down order by default is, the saturation of  blood oxygen trend chart, the apnea event 
length trend chart, the respiratory rate trend chart, the number of  snoring trend chart, 
and the heart rate trend chart. The horizontal axis stands for the elapsing of  time, with 
the time value marked above the horizontal axis. 

②Parameter deletion 

Parameters that can be deleted in the trend chart include blood oxygen, heart rate and 
respiratory rate. 

Using the  in the toolbar may delete the invalid parameters. 

If  a certain part of  the parameters during a period of  time is to be deleted, left-click your 
mouse and drag it to select the intended part in the chart, click the corresponding item 

from Trend of  the menu bar. You can also do it via the 、 、 、  icons in the 

toolbar. If  you just intent to delete some points in the chart, stay the cursor at the exact 

point and click the 、 、 、  button directly to erase them. 

③Event location 

Click with your mouse to make the cursor stay anywhere you want it to be. Also, clicking 
on the “ ” icon in the parameter page of  assistant window can bring you to the very 
moment when this event took place. For example, clicking the item is 
able to point the cursor to the moment of  the lowest value of  oxygen saturation. 

 ④Print 

Use  to print or print preview the charts or reports. The printing function also 

goes well in other pages. 

⑤Analysis 

If  the data analysis work is not done when you open the file or some parameters are not 
correctly analyzed, and a second analysis is necessary after an adjustment to the data, you 
can select the corresponding options to perform the respiratory analysis and/or snoring 
analysis. 

The toolbar has provided three commonly used analysis shortcuts. The buttons 

“ ” call the respiration event analytical process and the snoring analyzing process 

respectively. 
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Also, the analysis function works in other pages. 

Raw Data 

This page can show all the recorded signals both in waveform and in numeric value. By 
different walk speeds of  paper, this system can display in the current time scope all the 
recorded features in this page such as the recorded waveforms, the record parameters as 
well as the corresponding analysis results and the events.  

 

 
Figure 2-7  Waveform Display  

 
The following operations may be carried out in this page. 
Print 
Modify display setup 
Modify paper speed 
Modify time display 
Event browse 
Event edit 
Mark function 
 
① Print 

Select  in the menu or  in the toolbar to print the analysis report. 

② Modify display setup 
Move the cursor to a certain waveform and right-click with mouse to access the pop-up 
menu, select the correct item to change the gain and color of  the waveform. 
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③ Modify paper speed 
This function is aimed at conveniently observing the waveforms of  different types. 

The tool  in the toolbar can zoom in and zoom out the time scale 
to change the speed at which paper walks. The range is from 8s/page to 480 s/page. 
④ Modify time display 
This page provides many kinds of  methods for the operator to locate any period of  time 
conveniently to observe the waveform and its parameters. 

The two buttons  are used to slightly adjust the time back and forth as to when 

the waveform shall be displayed, with five seconds as a pace. 

The two buttons  are used for page turning with each page length depending 
on the present speed of  paper’s walking. For example, if  the current displaying waveform 
walks at 1 minute/page, it shows the waveform of  either previous or next one minute 
upon each clicking on the icons. 

The bar  is a time vernier, which 
could be dragged back and forth or clicked on to show a waveform in varying time 
ranges. 
 
Moving the mouse cursor to the left or right edges of  the waveform where the cursor 
changes to an arrow, can make the waveform walking at the speed of  2 seconds /page 
automatically. 
 
You can also locate the display contents in accordance with the markings you have made 
or the various events in your analysis. Refer to the event browse function and marking 
function in the following parts for details. 

⑤Event browse 

a）Breathing event 

All the breathing events are lined out with a series of  colorful blocks in the graph, with 
the serial number, the type and the length of  each one annotated nearby. These breathing 
events are categorized into HYP and OSA, which means hypopnea and obstructive sleep 
apnea, respectively. And a previous event or next event can be easily located by clicking 

the  buttons. 

b）Snore 

The symbol “★” indicates a snore. In this operation, evaluations can be made to the 
sensitivity of  snoring threshold and it can be adjusted by modifying the threshold of  
snoring identification and therefore changing the number of  snores. 

⑥ Event edit 
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The type and length of  breathing events can be revised and every event can be inserted 
or deleted in this page. 

For changing the breathing event type or deleting any event, right-click on the event and 
select the corresponding item to continue your action. 

For changing the length of  a breathing event, firstly point your mouse to the beginning 
or the end of  the block of  event, when the mouse arrow changes into a draggable state. 
Then drag the left or right edges to change the time of  beginning and end. 

For event insertion, left-click mouse and drag it to form rectangular block on the 
waveform, when a menu pops up, demonstrating the length of  this block. Select a 
corresponding event type to generate such an event. 

⑦Marking function 

When the operator feels particularly interested in any recorded part and intends to 
relocate it on his next opening of  the file, he may use this marking function, attaching 
different marks to different areas of  interests.  

Three symbols, A, B, and C are provided in this function. And the texts “+A”, “+B” or 
“+C” are shown at the bottom of  waveform. 

The  in the toolbar is used to make a mark or 

search for the previous or next mark. These markings can be kept while file-saving, thus 
can be relocated quickly upon later reopening.  

Respiration event 

This page has listed all respiration events and their correlations with the statistical data by 
form. 

The respiration event list may sort according to different statistical items, with just 
clicking on the corresponding statistical tags. And the list will be shown in the intended 
manner. 

Clicking on the list or using the ↑↓ key on keyboard may choose any event in the 
respiration event list. Click the corresponding button from the “Respiration Event” 
drop-down menu to change the type of  an event. The displaying order of  the list of  
events is not changed at the moment. 

Above the respiration event list is the corresponding waveforms where all the respiration 
events are characterized by blocks of  different color. Right-click on the event block, 
select the corresponding option to revise or delete an event. When the mouse arrow 
becomes draggalbe at the beginning or end of  an event block, you can drag it back and 
forth to shorten or lengthen the time of  the respiration event. Also, you can insert a 
respiration event by dragging a rectangular block in the waveform, and the list of  
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respiration events below will make a change to be ranged by serial numbers accordingly. 

Change the displaying page to a previous or next one, or, magnify and minify the time 

axis of  waveform by using the toolbar . 

If  the respiration event or the snore is to be analyzed for a second time, click 

 or  in the toolbar. 

   
  Figure 2-8  Respiration Event Edit 
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 Figure 2-9  Respiration Event 

Analysis form 

All analysis results are produced into concise reports after statistical analysis. If  the data 
recording has contained the CPAP pressure, a CPAP pressure report is also included. 

 
Figure 2-10  Analysis Report 
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Diagnosis result 

The conditions and results of  examination can be reached by selecting the corresponding 
items in the drop-down menu. Both English and Chinese can be inputted in the 
suggestion field. All the above reports can be printed out. 

 
Figure 2-11  Diagnosis Result 

Print preview and output 

When the waveform is in need of  printing, the waveform page should be activated to 

display. Press  button or click on preview from the File menu under this page to 
preview the present waveforms. 
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Figure 2-12  Print and Preview of the Raw Data Waveform 

 

In other pages, pressing   button or clicking on preview from the File menu may 
generate a window for preview options. Select the intended report and press 

 button, the preview of  report will be shown on the screen.  

 
Figure 2-13  Print and Preview of the Report 
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Similarly, selecting  button in the toolbar, or Print from File menu will show up the 

window for preview options. The print work will be done after you select your intended 

reports and press button. Click  to change the 

printer settings. 

Exit program 

To back to Windows desktop just click File in the menu and click Exit or  at the top 
right corner. 
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USB Driver as an Essential Support 

This driver is required to be installed only when the software is intended to replay and 
analyze the recorded data of  the SleepCare device. 

1. Make sure that the PC USB port works well. 

2. Plug the USB data cable in the USB socket. System will detect it and the “Found New 
Hardware Wizard” appears to set the new device. Otherwise, follow step 8 to manually 
install the driver. 

3. Insert the accompanying CD to the CD-ROM driver, and click “USB driver 
installation”. When the system asks you whether or not to connect to the internet for 
windows update, select “No, not for the moment”, and click “Next”. Select “Install from 
a list or specific location (Advanced)” and then click “Next”. 

4. Set the options according to figure 3-1 in the search and installation options page. Tick 
“search removable media (floppy, CD-ROM…)” and Click “Next”. 

5. The wizard continues with the installation after finding the driver. 

 
Figure 3-1  Found New Hardware Wizard 

6. Press “Finish” to quit the driver installation interface after installation. 

7. Right-click the shortcut “My Computer” on the desktop and enter the system 
properties interface, click “Device Manager” in the “hardware” page to check out 
whether the BMC USB Interface is seen under “USB Controller”. If  so, it is suggested 
that the USB driver for SleepCare has been set up successfully and it can work now. 

8. If  “? USB-Serial Controller” comes up in the device manager, the installation is 
supposed not to be done or not correct and need to add the driver again. 
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9. Right-click “? BMC USB Interface”. Select “Update Driver”. Follow step 3 to install 
driver under the direction of  the hardware update wizard of  the pop-up window. 
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Service 

Technical Support 

For technical support and before returning any equipment, call BMC MEDICAL CO., LTD. at 
86-10-51663880.  

Limited Warranty 

BMC MEDICAL CO., LTD. warrants that the SleepCare shall be free from defects of 
workmanship and materials and will perform in accordance with the product specifications for a 
period of one year from the date of delivery. During the warranty period, BMC MEDICAL CO., 
LTD. will correct any defects in material or workmanship to conform to specifications, free of 
charge. BMC MEDICAL CO., LTD. reserves the right to replace the SleepCare with a 
comparable unit. Shipping costs are the responsibility of the purchaser. This warranty does not 
cover damage caused by accident, misuse, abuse, alteration and other defects not related to 
material or workmanship. 
 
BMC MEDICAL CO., LTD. disclaims all liability for economic loss, loss of profits, overhead, or 
consequential damages which may be claimed to arise from any sale or use of this product. 
 

To exercise your rights under this warranty, contact your local, authorized dealers or: 

 

MANUFACTURED BY: 
 
BMC MEDICAL CO., LTD. 
5F North No.2 Building, No.9 Shixing Street, Shijingshan District, 
Beijing 100041, China 
Tel: 86-10-51663880 
Fax: 86-10-51663880 Ext. 810 
 
EU AUTHORISED REPRESENTATIVE: 
Shanghai International Trading Corp. GmbH (Hamburg) 
Eiffestrasse 80, 20537  Hamburg，Germany 
Tel: 0049-40-2513175  
Fax: 0049-40-255726 
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